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1

1

Getting Started

Your eMac has been designed so that you can set it up
quickly and start using it right away. If you have never
used an eMac or are new to Macintosh computers, read
this section for instructions on getting started.
If you are an experienced user, you may already know enough to get started. Be sure to
look over the information in Chapter 2, “Getting to Know Your eMac,” to find out about
the new features of this eMac.

Telephone cord

Keyboard
AC cord

Mouse

5
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Setting Up Your eMac
1 Plug the power cord firmly into the power socket (marked with the ≤ symbol on the
back of the computer) and plug the other end into a grounded outlet or power strip.
2 To enable Internet connectivity, connect your computer’s Ethernet port to an Ethernet
network or to your DSL or cable modem using an Ethernet cable. Or connect your
computer’s modem port (included on some models) to a telephone line using the
included phone cord and your computer’s modem port.

W Modem port
Ethernet port

Telephone cord
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3 Connect the keyboard cable to one of the USB ports ( ) on the computer. Plug the
mouse cable into a USB port on the keyboard.

4 Turn on your computer by pressing the Power button (®) on the side of the computer.

® Power button

Chapter 1 Getting Started
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Adjusting Your Display
To adjust the settings for your display, choose Apple (K) > System Preferences (click
the Apple menu and choose System Preferences) and click Displays.

Where to Go From Here
You’ve done everything you need to get your eMac up and running. The first time you
turn on your computer, the Setup Assistant takes you through the process of
configuring your computer and setting it up for the Internet. Internet access usually
requires an account with an Internet service provider (ISP). Fees may apply.
• If you don’t already have an Internet account, the assistant can set you up with one.
• If you already have an Internet account, see Appendix C, “Connecting to the
Internet,” on page 61 for information you’ll need to enter.
If you would like additional information, see the following:

8

To learn about...

See...

Shutting down your computer or putting
it to sleep

“What to Do When You Have Finished Using
Your eMac” on page 9.

What you can do with the hardware and software
features of your eMac

Chapter 2, “Getting to Know Your eMac.”

The additional information available in the
onscreen help

“Getting Answers to Your Questions Using Mac
OS Help” on page 22.

Using a specific feature of your eMac, or
connecting a digital device, such as an iPod

Chapter 3, “Using Your Computer.”

Installing memory or an AirPort Extreme Card

Chapter 4, “Enhancing Your Computer.”

What to do if you have a problem with your eMac

Chapter 5, “Troubleshooting.”

Chapter 1 Getting Started

LL2385.book Page 9 Thursday, September 4, 2003 5:20 PM

What to Do When You Have Finished Using Your eMac
When you have finished working with your eMac, you have two options.

Put Your eMac to Sleep
If you will be away from your eMac for less than a few days, put the computer to sleep.
When the computer is in sleep, its screen is dark and a small white light pulsates to the
right of the optical drive. You can quickly wake it and bypass the startup process.
To put the computer to sleep quickly, do one of the following:
• Choose Apple (K) > Sleep.
• Press the Power button.
To wake the computer, press any key on the keyboard.

Shut Down Your eMac
If you will not use your eMac for more than a few days, shut it down.
• Choose Apple (K) > Shut Down.

Warning: Shut down your eMac before moving it. Moving your computer while
the hard disk is spinning can damage the hard disk, causing loss of data or the
inability to start up from the hard disk.

Chapter 1 Getting Started
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2

Getting to Know Your eMac

2

This chapter gives you some basic information you’ll
need to know about your eMac.
Read on for an overview of the different parts of your computer and Mac OS X, and
summary information on common tasks such as customizing the way your desktop
looks, connecting to a printer, playing a CD, connecting a digital camera, using the
Internet, getting answers when you need help, and more.

For the Latest Information
Because Apple frequently releases new versions and updates to its system software,
images shown in this book may be slightly different from what you see on your screen.
The Apple website, at www.apple.com, links you to the latest Apple news, free
downloads, and online catalogs of software and hardware for your eMac.
You can also find the manuals for many Apple products and technical support for all of
Apple’s products on the AppleCare Service and Support website at www.apple.com/
support.

11
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eMac – Front View
Microphone

AirPort Extreme
Card slot (inside)

Optical disc drive

Power indicator light

- Volume controls

Stereo speakers

Media Eject key

USB ports

Apple Keyboard
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Apple Mouse
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Microphone
Record sounds directly on your eMac or talk with friends live over the Internet using the
included iChat AV application.
Optical disc drive
Your computer has a CD-ROM drive, a DVD-ROM/CD-RW Combo drive, or a SuperDrive.
Each drive can read CD-ROM discs, photo CDs, standard audio discs, and other kinds of
media. Both the Combo drive and SuperDrive can also read DVD discs and DVD movies,
and write music, documents, and other digital files to CD-R and CD-RW discs. The
SuperDrive can also write to blank DVD-R discs using the Finder or iDVD. To open the
drive, press the Media Eject ( ) key on your Apple keyboard.
Stereo speakers
Listen to music, movies, games, and multimedia.
Two USB (Universal Serial Bus) ports (on keyboard)
Connect low-power USB devices to your eMac’s keyboard, such as mice, digital cameras,
and joysticks. Connect your Apple mouse to one of the keyboard USB ports. There are
three more USB ports on the side of your computer.
AirPort Extreme Card slot
An AirPort Extreme Card in your computer allows you to connect to a wireless network.
Your eMac may have come with an AirPort Extreme Card already installed. If not, you can
purchase an AirPort Extreme Card and install it yourself. See “Installing an AirPort Extreme
Card” on page 41.
Power indicator light
A white light indicates that the computer is on. A pulsing light indicates the computer is
in sleep.

-

Volume controls
Increase or decrease the volume of the sound coming from the built-in speakers and
sound output port.
Media Eject key
Press and hold this key to eject a CD or DVD disc. You can also eject a disc by dragging its
desktop icon to the Trash.
Apple mouse
A precision optical mouse you can use on almost any surface, no mouse pad required.

Chapter 2 Getting to Know Your eMac
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eMac – Side View

Security slot
Memory access
(inside)

Power port

Headphone
jack

Audio line-in
port

14

® Power
button

USB
ports

FireWire
400 ports
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Modem
port

Ethernet
port

Video output
port
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Memory access (underneath)
Your eMac comes with at least 128 megabytes (MB) of Synchronous Dynamic RandomAccess Memory (SDRAM). There are two SDRAM slots, one of which is usually available for
expansion. The maximum amount of memory you can have in your eMac is 1 gigabyte
(GB), using two 512 MB SDRAM modules. For instructions, see “Installing Additional
Memory” on page 37.

f

Headphone port
Connect external speakers, headphones, or other sound output devices.
Audio line in port
Connect your eMac to a line-level microphone or other audio equipment.
Three USB (Universal Serial Bus) ports
Connect USB devices, such as printers, external hard disks, digital cameras, modems,
keyboards, and joysticks, to your eMac. There are two more USB ports on your keyboard.
Two FireWire 400 ports
Connect high-speed external devices, such as an iPod, digital video cameras, printers, and
external storage devices.

W

Modem port (on some models)
Connect a standard phone line directly to the internal 56K v.92 modem.

G

Ethernet port (10/100Base-T)
Connect to a high-speed 10/100Base-T Ethernet network, a DSL or cable modem, or
connect to another computer and transfer files. The Ethernet port auto-sensing feature
detects other Ethernet devices. You don’t need an Ethernet crossover cable to connect to
other Ethernet devices.
Video out port
Using the optional Apple VGA Display Adapter (available at www.apple.com/store),
connect to an external monitor or projection device that uses a VGA connector. Using the
optional Apple Video Adapter (available at www.apple.com/store), connect your eMac to
a television, VCR, or another video device that uses an S-video or composite video
connector.

®

Power button
Turn on your eMac or put it to sleep. Press and hold to reset during troubleshooting.

≤

Power socket
Connect the computer’s power cord.
Security slot
Protect your eMac by connecting a security cable.

Chapter 2 Getting to Know Your eMac
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Learning About Mac OS X
Your computer comes with Mac OS X and features Classic, an environment for using
Mac OS 9 applications while the computer is running Mac OS X.
Note: Mac OS 9 cannot be installed as the primary operating system on your eMac.
Mac OS X features include an elegant user interface, advanced graphics capabilities,
and added system stability and performance.

When you’re ready to learn more about Mac OS X and the applications that came with
your computer, see the Welcome to Panther booklet that came with your eMac. Also
open Mac OS Help and browse the information there. You’ll find plenty of information
for new users, experienced users, and people switching to the Mac. If you experience
any problems while using Mac OS X, see the troubleshooting tips in the back of this
book or choose Help > Mac Help from the menu bar at the top of the screen.
For information about the compatibility of software applications with Mac OS X, or to
read more about Mac OS X, check the Apple website: www.apple.com/macosx.

16
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Customizing Your Desktop and Setting Your Preferences
You can quickly make your desktop look the way you want using System Preferences.
Choose Apple (K) > System Preferences from the menu bar.

Feel free to make changes and experiment with the following:
• Desktop & Screen Saver: Select this preference pane to change the background
color or pattern of your desktop, or change it to a photo or image you like. You can
also choose an eye-catching screen effect that will appear on your screen when the
computer is left idle.
• Dock: Select this preference pane to change the look, location, and behavior of your
Dock.
• Appearance: Select this preference pane to change the colors of buttons, menus,
windows, and highlight colors, among other options.
As you get to know your computer, explore the other System Preferences. It is your
command center for most settings on your eMac. For more information, open Mac OS
Help and search for “System Preferences” or for the specific preference you want to
change.

Chapter 2 Getting to Know Your eMac
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Connecting to a Printer
To use a printer with your eMac, follow the instructions that came with the printer to
install required software and connect the printer. Many printers connect via a USB
cable; others are accessed via a network connection, such as Ethernet. For more
information about your USB ports, see “Ethernet (10/100Base-T)” on page 29. For more
information about a network or wireless connection, see “Ethernet (10/100Base-T)” on
page 29 and “AirPort Extreme Wireless Internet and Networking” on page 27.
After connecting and setting up your printer, use the Print & Fax pane of System
Preferences to select your printer for use. If you’re connecting to a printer via a network,
you may need to know the network name or address of the printer to select it. If you
have a USB printer connected to an AirPort Extreme Base Station, and you have an
AirPort Extreme Card installed in your eMac, you can connect to the printer and print
wirelessly.
To set up a printer:
1 Open System Preferences and click the Print & Fax icon.
2 Click the Set Up Printers button.
3 Click the Add button.
4 Choose the type of connection for your printer (for example, USB, AppleTalk, and so
on).

To add a USB printer connected to an AirPort Extreme Base Station, choose Rendezvous
from the pop-up menu.
5 Select or enter your printer information and click Add.

18
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Monitoring Printing
Once you’ve sent a document to a printer, you can monitor printing and halt or put it
temporarily on hold.
m

To monitor printing:
Click the Printer icon in the Dock to open the Printer window.
You can now see the print jobs in the print queue and work with them. For more
information, open Mac OS Help (see page 22) and search for “printing.”

Playing a CD and Connecting Headphones
If you’d like to listen to music while you work with your eMac, insert a music CD in your
optical drive. iTunes, an easy-to-use music player, will appear automatically on the
screen. You can also connect headphones with a minijack to the headphone port of
your eMac to listen privately. To learn more about iTunes, open iTunes and choose
Help > iTunes & Music Store Help. To learn more about your optical drive, see “Using
Your Optical Drive” on page 32.

Keeping Your Software Up to Date
You can connect to the Internet and automatically download and install the latest free
software versions, drivers, and other enhancements from Apple.
When you are connected to the Internet, Software Update checks Apple’s Internet
servers to see if any updates are available for your computer. You can set your Mac to
check the Apple server periodically and download and install updated software.
To check for updated software:
1 Open System Preferences.
2 Click the Software Update icon and follow the directions on the screen.

Chapter 2 Getting to Know Your eMac
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• For more information, search for “Software Update” in Mac OS Help (see page 22).
• For the latest information on the Mac OS, go to the Mac OS website at

www.apple.com/macos.

Connecting a Camera or Other FireWire Device
If you have an iPod, iSight camera, digital video camera, or other device that has a
FireWire connector, you can connect it to your eMac. Follow the installation instructions
that came with your device. For more information about FireWire, see “FireWire” on
page 26.

Connecting to a Network
If you want to connect your eMac to an Ethernet network, cable or DSL modem, or a
wireless network, see “Ethernet (10/100Base-T)” on page 29 and “AirPort Extreme
Wireless Internet and Networking” on page 27 for more information about setting up
an Ethernet or AirPort connection. Also open Mac OS Help (see page 22) and search for
“Ethernet” or “AirPort” for further help.

Using the Internet
When you first set up your eMac, you were instructed on how to connect to the
Internet. If you need to change to a different type of connection, such as DSL, cable
modem, Ethernet local area network (LAN), or AirPort Extreme network, you can find
more information in Appendix C, “Connecting to the Internet,” on page 61.

Transferring Files to Another Computer
If you want to transfer files or documents to or from your eMac, you have several ways
of doing it.
• You can transfer files via the Internet using .Mac or another Internet account.
• You can transfer files to another computer on a network. To access another server or
computer, choose Go > Connect to Server from the Finder menu bar.
• You can create a small Ethernet network by connecting an Ethernet cable from your
eMac to another computer’s Ethernet port. For more information, open Mac OS Help
and search for “Connecting two computers.”
• You can also connect to another Mac using a FireWire cable. Your eMac appears as a
disk drive on the other computer and you can transfer files. For information about
using FireWire to transfer files, see “FireWire Target Disk Mode” on page 27.

20
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• If your computer has an AirPort Extreme Card, you can connect to an AirPort Extreme

wireless network to transfer files. For more information, see “AirPort Extreme Wireless
Internet and Networking” on page 27.
For general information about transferring files and documents, see “Switching to the
Mac,” located in the “User Guides and Information” folder on your hard disk. Also open
Mac OS Help and search for the type of connection you need.

When an Application Freezes
On rare occasions, an application may freeze on the screen. Mac OS X provides a way to
quit a frozen application without restarting your computer. Quitting a frozen
application may allow you to save your work in other open applications.
To force an application to quit:
1 Press Command (x)-Option-Esc.
The Force Quit Applications dialog appears with the application selected.

2 Click Force Quit.
The application quits, leaving all other applications open.
If needed, you can force the Classic Environment to quit, which closes all Classic
applications. You can also restart the Finder from this dialog.
If you’re experiencing other problems, see Chapter 5, “Troubleshooting,” on page 49.

Chapter 2 Getting to Know Your eMac
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Getting Answers to Your Questions Using Mac OS Help
You can find answers to most of your questions about using your computer and
Mac OS X using Mac OS Help onscreen.

To Use Mac OS Help
1 Click the Finder icon in the Dock.
2 Choose Help > Mac Help (click the Help menu and choose Mac Help).
3 Type a question and press the Return key on your keyboard.
4 Double-click an item in the list of Help topics.

Using Applications
Your eMac comes with software applications for doing things like sending
email, surfing the Internet, chatting online, organizing music and digital photos,
making movies, and much more. For more information on these applications, see the
Welcome to Panther booklet that came with your computer.

22
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3

Using Your Computer

3

Your eMac has many built-in features and expansion
capabilities you can use to customize your computer to
fit your needs.
Here are some of your computer’s features and capabilities:
• Universal Serial Bus (USB) ports for connecting additional equipment, such as
printers, scanners, joysticks, keyboards, digital cameras, and floppy disk drives.
• FireWire ports for connecting high-speed equipment, such as an iPod, iSight camera,
digital video cameras, and external hard drives.
• The latest in communications technologies, such as a 56K v.92 modem (on some
models), 10/100Base-T Ethernet, and optional AirPort Extreme wireless Internet and
networking.
• VGA output with the Apple VGA Display Adapter (available at www.apple.com/store)
lets you the use your eMac with an external monitor or video projector. Use your
eMac’s video out port and the Apple Video Adapter (available at www.apple.com/
store) to present what’s on your computer’s screen on any television that supports
composite or S-video.
• Audio line in port, headphone port, and more.
To learn about what you can do with your eMac, start with the information in this
chapter. Additional information can be found in Mac OS Help (see page 22) and on the
many Apple websites.

23
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Universal Serial Bus (USB)
Your eMac comes with five USB ports ( ) (three on the computer and two on the
keyboard), which you can use to connect many types of external devices, including
printers, scanners, digital cameras, game pads, joysticks, keyboards, and floppy disk
drives. USB makes it easy to connect external equipment. In most cases you can
connect and disconnect a USB device while the computer is running. Once you
connect the device, it is ready to use.

Using USB Devices
To use a USB device with your computer, simply connect the device to the computer.
Your computer automatically accesses the necessary software whenever you connect a
new device.
Note: Apple has already included software to work with many USB devices. When you
connect a USB device, if your eMac cannot find the correct software, you can install the
software that came with the device or check the device manufacturer’s website for the
latest software.

24
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Using Multiple USB Devices at the Same Time
If all of your USB ports are being used and you want to connect more USB devices, you
can purchase a USB hub. The USB hub connects to an open USB port on your computer
and provides additional USB ports (usually four or seven). Most USB hubs also have a
power adapter and should be plugged into an outlet.

USB hub

For More Information on USB
Additional information on USB is available in Mac OS Help (see page 22). Choose Help
> Mac Help and search for “USB.” You can also find information on the Apple USB
website at www.apple.com/usb.
For information on USB devices available for your computer, check the Macintosh
Products Guide at www.apple.com/guide.

Chapter 3 Using Your Computer
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FireWire
Your computer has two FireWire 400 ports ( ). FireWire lets you easily connect and
disconnect external high-speed devices—such as an iPod, an iSight camera, DV
cameras, printers, scanners, and hard disks. You can connect and disconnect FireWire
devices without restarting your computer.

These are some of the things you can do with FireWire:
• Connect an iPod and transfer thousands of songs from iTunes or synchronize contact
and calendar information using iSync.
• Connect a digital video camera and capture, transfer, and edit high-quality video
directly on your computer using video-editing software such as iMovie, Final Cut Pro,
or Final Cut Express.
• Connect an external FireWire hard disk drive and use it to back up data or transfer
files.
A FireWire hard disk icon appears on your desktop after you connect the drive to
your eMac.
• Start up from an external FireWire hard disk. Connect an external FireWire disk (with
a valid operating system installed on it), open the Startup Disk pane of System
Preferences, and click the FireWire disk. Restart your computer.

Using FireWire Devices
To use a FireWire device with your computer, simply connect the device to the
computer. Apple has already included software to work with many FireWire devices.
When you connect a FireWire device, if your eMac cannot find the correct software, you
can install the software that came with the device or check the device manufacturer’s
website for the latest software.

26
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Note: The FireWire port is designed to provide power for FireWire devices (up to 8
watts maximum). You can connect multiple devices to each other and connect the
“daisy-chain” of devices to the FireWire port on your computer. In most cases, at most
two devices should get power from the computer. If you connect more than two
devices, the rest of the devices in the daisy-chain should be powered by separate
power adapters. Connecting more than two FireWire devices that get power from the
computer may cause problems. If a problem occurs, shut down the computer,
disconnect the FireWire devices, and restart your computer.

FireWire Target Disk Mode
If you want to transfer files between your eMac and another FireWire-equipped
computer, or you have a problem that prevents your computer from starting up, you
can use FireWire Target Disk Mode to connect to another computer.
To connect your eMac in FireWire Target Disk Mode, follow these steps:
1 Make sure that your eMac is shut down.
2 Use a FireWire cable with a standard 6-pin connector on each end to connect your
eMac to another FireWire-equipped computer.
3 Start up your eMac and immediately hold down the T key. Your eMac display shows the
FireWire logo. The other computer’s display shows the eMac internal hard disk icon and
the icon of a CD or DVD disc in the eMac’s optical drive.
4 When you are finished transferring files, drag the eMac hard disk icon and the CD or
DVD disc icon to the Trash.
5 Press the Power button on the eMac to shut it down, and then disconnect the
FireWire cable.

For More Information on FireWire
Additional information on FireWire is available in Mac OS Help (see page 22). Choose
Help > Mac Help and search for “FireWire.” You can also find information on the Apple
FireWire website at www.apple.com/firewire.

AirPort Extreme Wireless Internet and Networking
Your eMac is AirPort Extreme-ready. If you ordered an AirPort Extreme Card when you
purchased your eMac, the card is already installed. If you do not have an AirPort
Extreme Card installed and would like to install one, see page 41 for more information.
AirPort offers an easy and affordable way to provide wireless Internet access anywhere
in the home, at work, or in the classroom. Instead of using traditional cables, AirPort
uses wireless local area network (LAN) technology to provide wireless communication
between multiple computers. Through a wireless network you can set up access to the
Internet, transfer files, play multiplayer games, and more.

Chapter 3 Using Your Computer
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Note: Wireless Internet access requires an AirPort Extreme Card. Previous models of
AirPort Card are not compatible with your computer. You also need an AirPort Base
Station and Internet access (fees may apply). Some Internet service providers are not
currently compatible with AirPort. Range may vary with site conditions.

How AirPort Provides Wireless Internet Access
With AirPort, you set up a wireless connection to a device known as a base station,
which has a physical connection to the Internet. AirPort technology works like a
cordless telephone. The AirPort Extreme Card in the computer makes a wireless
connection to the base station, which is connected to the Internet via a telephone line
or a DSL or cable modem.
Connection to the Internet
AC outlet
AirPort Extreme
Base Station

For More Information on AirPort
To purchase an AirPort Base Station, contact your Apple-authorized dealer or go to the
Apple Store at www.apple.com/store.
Additional information on AirPort is available in AirPort Help. Choose Help > Mac Help,
then choose Library > AirPort Help. You can also find information on the Apple AirPort
website at www.apple.com/airport and in the Apple Knowledge Base at
kbase.info.apple.com.
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Ethernet (10/100Base-T)
Your computer comes with built-in 10/100 megabit per second (Mbps) Base-T (twistedpair) Ethernet networking capability, which you can use to connect to a network or to a
cable or DSL modem.

Connecting to a network gives you access to other computers. You may be able to
store and retrieve information; use network printers, modems, and electronic mail; or
connect to the Internet. You can also use Ethernet to share files between two
computers or set up a small network. The Ethernet port on your eMac automatically
detects other Ethernet devices. You don’t need an Ethernet crossover cable to connect
to other Ethernet devices.
• Use 2-pair category 3 (Cat 3) Ethernet cables to connect to a 10Base-T Ethernet
network.
• Use 2-pair category 5 (Cat 5) Ethernet cables to connect to a 10Base-T or a 100Base-T
Ethernet network.

For More Information on Using Ethernet
Additional information, including how to set up an Ethernet network and transfer files
using Ethernet, is available in Mac OS Help (see page 22). Choose Help > Mac Help and
search for “Ethernet” or “network.”
For information on networking products you can use with your eMac, check the
Macintosh Products Guide at www.apple.com/guide.
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External Video Support (VGA, Composite, and S-Video)
Your computer has a video out port you can use to connect an external display
(monitor) or VGA projector, using the Apple VGA Display Adapter (available at
www.apple.com/store).
You can also display or record computer images by connecting a TV, video projector, or
videocassette recorder (VCR), using the Apple Video Adapter (available at
www.apple.com/store).
Note: The Apple Video Adapter is not compatible with some previous models of eMac.

Apple VGA adapter

Æ S-video out port
Composite video port

Apple Video adapter
Æ

When an external monitor or television is connected, the same image appears on both
the eMac display and the external monitor (known as video mirroring).
Note: Because of the display limitations of most televisions, images displayed on
a television screen are of lower quality than those on the built-in display or
external monitor.
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Connecting an External Display or Projector
To connect an external display or projector to your computer with a VGA
connector:
1 Turn on the external display or projector.
2 Connect the Apple VGA Display Adapter to the VGA port on the external display or
projector.
3 Connect the Apple VGA Display Adapter to your eMac. Your eMac automatically detects
the external display.
Important: To ensure that your eMac automatically detects the external display
or projector, be sure the VGA adapter is plugged into the external display or projector
first.
4 Use the Displays pane of System Preferences to adjust the resolution on the external
display or projector.

Connecting a Television, VCR, or Other Video Device
To connect a TV, VCR, or other video device to the eMac:
1 Connect the single-plug end of the Apple Video Adapter to the video out port on your
eMac.
2 Connect the other end of the adapter to the composite video port or the S-video port
on the TV or VCR.
3 Turn on the external device.
4 To adjust how the images are displayed on the device, use the Displays pane of System
Preferences.
The image appears on both the eMac and the TV, except for DVD playback, which
appears only on the TV.

For More Information on Using an External Display or TV
Additional information on using and configuring an external monitor is available in
Mac OS Help. Choose Help > Mac Help and search for “display.”
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Using Your Optical Drive
You can install or use software from CDs using your optical drive. You can play
multimedia content (such as QuickTime movies) from CD discs and music from
audio CDs.
If your eMac has a DVD/CD-RW Combo drive or a SuperDrive, you can burn music CDs,
and save documents and other digital files on CD-R and CD-RW discs. You can also play
DVD movies and use most DVD discs.
If your eMac has a SuperDrive, you can also use your home movies to make video DVDs
that can by played in most home DVD players, or save documents to blank DVD-R
(recordable DVD) discs.
Note: If you have older software that comes on floppy disks, contact the software
manufacturer to see if the software is available on a CD or for download from the web,
or purchase an external USB floppy disk drive for your eMac from your Apple dealer or
the Apple Store (www.apple.com/store).

Inserting a CD or DVD Disc
To install or use programs from a CD or DVD disc, follow these steps:
1 With the computer turned on, press the Media Eject key ( ) on the keyboard to open
the drive tray.
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2 Place the disc flat on the tray, with the label facing up, and press the Media Eject key
again to close the tray.
Note: Some DVD discs are two-sided.

3 When the icon for the disc appears on the desktop, the disc is ready to use.

Ejecting a Disc
To eject a disc, do one of the following:
• Drag the disc icon to the Trash.
• Press and hold the Media Eject ( ) key on the keyboard until the disc ejects.
If you can’t eject the disc, quit any applications that may be using the disc and try
again. If that doesn’t work, restart the computer while holding down the mouse
button.
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Playing DVD Discs
If your eMac has a DVD/CD-RW Combo drive or a SuperDrive, you can play standard
DVD-Video discs. To play a DVD, insert the DVD disc. DVD Player opens automatically
and starts playing the disc.
If your eMac is connected to a TV so that you can watch DVD playback on the TV
screen, select 720 x 480 NTSC (in the United States) or 720 x 576 PAL (in Europe and
other regions) in the Displays pane of System Preferences.
You can easily connect your eMac to your stereo system. Use a 3.5-millimeter miniplugto-RCA cable (not included) to connect the headphone port (f ) on your eMac to the
audio input ports on your stereo.

Recording CD-R and CD-RW Discs
If your eMac has a DVD/CD-RW Combo drive or a SuperDrive, you can record music on
CD-R or CD-RW discs right from your iTunes library.
To record music to a CD-R or CD-RW disc:
1 Click the iTunes icon in the Dock.
2 Select the playlist you want to record.
3 Insert a blank CD-R or CD-RW disc. (For highest compatibility with CD players,
use a CD-R disc.)
4 At the top of the iTunes window, click Burn CD.
You can also record data on CD-R and CD-RW discs:
1 Insert a blank disc in the optical drive.
2 In the dialog that appears, enter a name for the disc. An icon for the CD appears on the
desktop.
3 Drag files and folders to the disc icon.
4 Choose File > Burn Disc, or select the disc and drag it to the Burn Disc icon in the Dock.

For More Information
• For information about how to use iTunes to record music files on a CD-R disc,

open iTunes and choose Help > iTunes & Music Store Help.
• For instructions on using DVD Player, open DVD Player and choose

Help > DVD Player Help.
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Recording Information on a DVD
If your eMac has a SuperDrive, you can record your own digital movies on a blank
DVD-R (DVD-Recordable) disc. You can also record other kinds of digital data (for
example, you can back up your files to DVD-R discs).
With iDVD, you can create your own customized DVD, burn it on a blank DVD-R disc,
and play it on most standard DVD players.
To burn an iDVD project to a blank DVD:
1 Open iDVD and open your completed DVD project.
2 Click the Burn button.
3 Insert a new blank DVD-R disc into the drive when prompted.
4 Click the Burn button again.
To record data to a DVD-R disc:
1 Insert a blank DVD-R disc in the drive.
2 In the dialog that appears, enter a name for the disc and select the format you want to
create. An icon for the DVD appears on the desktop.
3 Double-click the DVD icon, then drag files and folders to it.
4 Choose File > Burn Disc, or select the disc and drag it to the Burn Disc icon in the Dock.
For more information about how to use iDVD, open iDVD and choose Help > iDVD
Help.
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Keyboard Controls
You can quickly adjust the volume or eject a CD or DVD disc using the keyboard
controls.
Mute key

Volume Down key

Media Eject key

Volume Up key

Securing Your Computer
Use a locking cable and the built-in security slot to attach your eMac to a stationary
object.

Sample locking device
with security cable

Additional information on the software security features of your eMac, including
multiple user passwords and file encryption, is available in Mac OS Help (see page 22).
Choose Help > Mac Help and search for “security” or “multiple users.”

36

Chapter 3 Using Your Computer

LL2385.book Page 37 Thursday, September 4, 2003 5:20 PM

4

Enhancing Your Computer

4

This chapter provides information and instructions for
enhancing your computer.
Instructions are provided for the following procedures:
• “Installing Additional Memory” on page 37
• “Installing an AirPort Extreme Card” on page 41
Warning: Apple recommends that you have an Apple-certified technician install
memory. Consult the service and support information that came with your
computer for instructions on how to contact Apple for service. If you attempt to
install memory and damage your equipment, such damage is not covered by the
limited warranty on your computer.

Installing Additional Memory
Your eMac comes with at least 128 megabytes (MB) of Synchronous Dynamic RandomAccess Memory (SDRAM). There are two SDRAM slots, one of which is usually available
for expansion. Each memory slot accepts any memory module that meets the
following specifications:
• Dual Inline Memory Module (DIMM)
• 3.3 volt (V)
• Unbuffered
• 64-bit wide, 168-pin module
• PC-133 compliant
The maximum amount of RAM you can have in your eMac is 1 gigabyte (GB), using two
512 MB memory modules.
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To install additional memory:
1 Turn your computer off by choosing Apple (K) > Shut Down. Disconnect all cables
except the power cord from your computer.
2 Place a soft, clean towel or cloth on the desk or surface. Slowly lift up and turn the
computer so the screen is facing down on the cloth.

3 Use a Phillips screwdriver to loosen the captive screw on the memory access panel.
Then gently remove the access panel.
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4 Touch metal inside the computer to protect the computer from damage caused by
electrostatic discharge.

Important: Always discharge static electricity before you touch any parts or install any
components inside the computer. To avoid generating static electricity, do not walk
around the room until you have finished installing the memory and closed the
computer.
5 Disconnect the power cord from the computer.
6 Insert the memory module into the memory slot. The module fits into the slot only one
way. Be sure to align the notches on the module with the small notches inside the slot.
With the ejectors in the open position, push down on the DIMM until it locks into
place. The ejectors will automatically close.

Chapter 4 Enhancing Your Computer
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7 Hold the access panel against the base of the computer and tighten the screw.

8 Gently turn the computer right side up. Then reconnect the cables you disconnected
from your computer.
9 Press the Power button on the side of your computer to turn it on.
Warning: Operating the computer when it is open or missing parts can be
dangerous and could damage your computer.

Making Sure Your Computer Recognizes the New Memory
After installing additional memory in your eMac, check whether the computer
recognizes the new memory. Do the following:
1 Start up your computer.
2 When you see the Mac OS desktop, choose Apple (K) > About This Mac.

Total memory installed
in your eMac
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The total includes the amount of memory that originally came with the computer plus
the new memory you added. For a more detailed breakdown of the amount of
memory installed in your computer, open Apple System Profiler by clicking More Info.
If your computer doesn’t recognize the memory or it doesn’t start up correctly, shut
down your eMac and check the instructions again to make sure that the memory you
installed is compatible with this eMac and that it is installed correctly. If you still have
problems, remove the memory and consult the support information that came with
the memory or contact the vendor who provided the memory.

Installing an AirPort Extreme Card
If your computer did not come with an AirPort Extreme Card, you can purchase one
from your Apple-authorized dealer or from the Apple Store at www.apple.com/store
and install it yourself or have it installed by an Apple-authorized service provider.
Note: Your eMac is not compatible with older AirPort Cards. Use only an AirPort
Extreme Card.
To install an AirPort Extreme Card in your eMac:
1 Press the Media Eject key ( ) on the keyboard to open the access door. Then hold the
door open and press the eject key again to retract the drive tray.

2 Turn your computer off by choosing Apple (K) > Shut Down.
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3 Loosen the captive screws on the AirPort access panel using a Phillips screwdriver. Then
remove the panel and unhook the antenna from the panel.

4 Insert the AirPort Extreme Card partially into the slot, with the logo facing down, then
connect the antenna firmly to the card.
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5 Push the AirPort Extreme Card firmly into the slot and tuck the antenna down into the
computer. You may need to lift the card slightly as you push it in.

Important: Be sure to push the AirPort Extreme Card firmly all the way into the slot.
6 Tuck the tab on the AirPort Extreme Card down into the computer.

Chapter 4 Enhancing Your Computer

43

LL2385.book Page 44 Thursday, September 4, 2003 5:20 PM

7 Replace the AirPort access panel.

8 Press the Power button on the side of your computer to turn it on.
If there is an AirPort network in range, you can select it using the AirPort status icon in
the menu bar. If you want to set up an AirPort Base Station, use the AirPort Setup
Assistant, in Applications/Utilities.
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Replacing the Internal Backup Battery
Your computer has a backup battery that preserves certain settings, such as the date
and time, when the computer is off.
You may need to replace the battery if you have intermittent problems starting up your
computer, or if settings such as the date and time change when you start up your
computer.
You can purchase a replacement 3.6V, 1/2AA leadless lithium battery at most
electronics or computer stores.
Note: If your computer is plugged into a power strip, Apple recommends you leave the
strip turned on to avoid shortening battery life.
To replace the internal backup battery:
1 Turn your computer off by choosing Apple (K) > Shut Down. Disconnect all cables
except the power cord from your computer.
2 Place a soft, clean towel or cloth on the desk or surface. Slowly lift up and turn the
computer so the screen is facing down on the cloth.
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3 Use a Phillips screwdriver to loosen the captive screw on the memory access panel.
Then gently remove the access panel.

4 Touch metal inside the computer to protect the computer from damage caused by
electrostatic discharge.

Important: Always discharge static electricity before you touch any parts or install any
components inside the computer. To avoid generating static electricity, do not walk
around the room until you have finished installing the memory and closed the
computer.
5 Disconnect the power cord from the computer.
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6 Remove the internal backup battery and replace it with the new one. Make sure to
align the plus sign (+) on the battery with the one inside the computer.

7 Locate the PMU reset button inside the computer. Push the button for one second
using a pen or pencil.
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8 Hold the access panel against the base of the computer and tighten the screw.

9 Gently turn the computer right side up. Then reconnect the cables you disconnected
from your computer.
10 Press the Power button on the side of your computer to turn it on.
Warning: Operating the computer when it is open or missing parts can be
dangerous and could damage your computer.
11 Dispose of the old battery according to your local environmental guidelines.
Replacing the battery may cause some settings on your computer, such as date and
time, to revert to the factory default settings. You may also have to restore modem
settings in any communications programs you use.
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5

Troubleshooting

5

Occasionally you may have problems while working with
your eMac. This chapter gives you some solutions to try
when you have a problem.
Most problems occur because your software isn’t properly set up or you’re using
software that isn’t compatible with the version of the Mac OS (system software)
installed on your computer. Other less likely sources include problems with the Mac OS
or problems with your computer’s hardware, such as the memory or hard disk.
When you experience a problem with your computer, it’s important to remember that
there is usually a simple and quick solution. When you encounter a problem, be aware
of the conditions that led up to the problem. Making a note of things you did before
the problem occurred will help you narrow down the possible causes of the problem
and then find the answers you need. Things to note include:
• The applications you were using when the problem occurred. Problems that occur
only with a specific application may indicate that the application is not compatible
with the version of the Mac OS installed on your computer.
• Any software that you recently installed. Certain applications install extensions that
may not be compatible with the Classic environment.
• Any new hardware (such as additional memory or a peripheral) that you installed.

What You’ll Find in This Chapter
This chapter contains solutions to problems that prevent you from working with your
computer, such as a system freeze or a computer that will not start up. You can find
more troubleshooting information in Mac Help (see page 22), on the Apple Support
website at www.apple.com/support, and in the Apple Knowledge Base at
kbase.info.apple.com.
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Problems That Prevent You From Using Your Computer
If the computer won’t respond or the pointer won’t move
• First, make sure the mouse and keyboard are connected. Unplug and then plug in
the connectors and make sure they are secure.
• If that doesn’t work, try to force problem applications to quit. Hold down the Option
and Command (x) keys and then press the Esc key. If a dialog appears, select the
application and click Force Quit. Then save your work in any open applications and
restart the computer to be sure the problem is entirely cleared up.
• If you are unable to force the application to quit, press and hold the Power button
(®) for a few seconds to shut down the computer.
• If that doesn’t work, unplug the power cord from the computer. Then plug the power
cord back in and press the Power button (®) on the computer to turn it on.
If the problem occurs frequently when you use a particular application, check with the
application’s manufacturer to see if it is compatible with your computer.
For support and contact information about the software that came with your
computer, go to www.apple.com/guide.
If the problem occurs frequently, you may need to reinstall your system software (see
“Restoring Your Computer’s Software” on page 51).
If the computer freezes during startup or you see a flashing question mark
• Wait a few seconds. If the computer doesn’t start up after a delay, shut down your
computer by pressing and holding the Power button (®) for about 5 seconds, until
the computer shuts down. Then hold down the Option key and press the Power
button (®) again to start up your computer. When your computer starts up, click the
hard disk icon, then click the right arrow.
• After the computer starts up, open System Preferences and click Startup Disk. Select
a local Mac OS X System folder.
• If the problem occurs frequently, you may need to reinstall your system software (see
“Restoring Your Computer’s Software” on page 51).
If the computer won’t turn on or start up
• Make sure the power cord is plugged into the computer and into a functioning
power outlet.
• If that does not work, press the Power button (®) and immediately hold down the
Command (x), Option, P, and R keys until you hear the startup sound a second time.
• If you recently installed additional memory, make sure that it is correctly installed
and that it is compatible with your computer. See whether removing it allows the
computer to start up (see page 37).
• If you are still unable to start up your computer, see the service and support
information that came with your eMac for information on contacting Apple for
service.
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Restoring Your Computer’s Software
Use the Software Install and Restore discs that came with your computer to reinstall
Mac OS X, applications, or Classic support. Some models of eMac come with a series of
Software Install CDs and another series of Software Restore CDs, and some models
come with a single series of Software Install and Restore DVDs.
m

To restore all of your computer’s software:
Follow the instructions below to reinstall Mac OS X, then follow the instructions to
reinstall applications and Classic support.

Reinstalling Mac OS X
1 Back up essential files, if possible.
2 Insert the first Software Install and Restore disc (or the first Software Install disc) that
came with your computer.
3 Double-click the Install Mac OS X icon.
4 Follow the onscreen instructions.
5 After selecting the destination disk for installation, click Options and continue following
the onscreen instructions.

Reinstalling Applications and Classic Support
To reinstall applications and Classic support if your eMac came with two
Software Install and Restore DVDs:
1 Back up essential files, if possible.
2 Insert the first Software Install and Restore disc that came with your computer.
3 Double-click the “Install Applications and Classic Support” icon.
4 Follow the onscreen instructions.
To reinstall applications and Classic support if your eMac came with multiple
Software Install and Software Restore CDs:
1 Back up essential files, if possible.
2 Insert the first Software Restore disc. Double-click the “SoftwareRestore.pkg” icon to
install the Software Restore application.
3 Follow the onscreen instructions to restore your computer’s software.
Note: iCal, iChat AV, iMovie, iPhoto, iSync, and iTunes are part of Mac OS X. To install
them you must follow the directions for installing Mac OS X (above).
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Other Problems
If you have a problem with an application
• For problems with software from a manufacturer other than Apple, contact the
manufacturer. Software manufacturers often provide updates to their software on
their websites. You can configure your eMac to automatically check for and install the
latest Apple software using the Software Update pane of System Preferences. For
more information, choose Help > Mac Help and search for “software update.”
If you have trouble using AirPort wireless communication
• Make sure you have properly configured the software according to the instructions
that came with your AirPort Extreme Card or AirPort Base Station.
• Make sure the computer or network you are trying to connect to is running and has
a wireless access point.
• Make sure you are within antenna range of the other computer or the network’s
access point. Nearby electronic devices or metal structures can interfere with wireless
communication and reduce this range. Repositioning or rotating the computer may
improve reception.
• Check the AirPort signal level:
• In Mac OS X, there are up to four bars in the AirPort status icon in the menu bar.
• In Classic, there are up to five green dots in the AirPort portion of the Control Strip.
• You may experience network performance problems if a microwave oven, cordless
phone, or other source of interference is used frequently near your base station. To
minimize interference, move the base station away from the device.
• For more information on using and troubleshooting AirPort, choose Help > Mac Help,
then choose Library > AirPort Help.
If you have trouble ejecting a disc
• Quit any applications that may be using the disc and try again. If that doesn’t work,
restart the computer while holding down the mouse button.
If you have problems with your Internet connection
• Make sure your telephone line or network cable is connected and functioning
properly.
• If you are using a dialup Internet connection, make sure that your telephone cord is
plugged into the modem port (marked with the icon W) and not the Ethernet port
(marked with the icon G).
• See “Connecting to the Internet” on page 61 for information on setting up your
computer to connect to the Internet. There you will find how to locate your Internet
settings and the contact information for your Internet service provider (if you used
the Setup Assistant to get your Internet account).
• See “Troubleshooting Your Connection” on page 64 for more information if you have
problems with your Internet connection.
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If you have a problem using your computer or working with the Mac OS
• If the answers to your questions are not in this manual, look in Mac Help for
instructions and troubleshooting information.
• Check the Apple Support website at www.apple.com/support for the latest
troubleshooting information and software updates.
If your date and time settings get lost repeatedly
• You may need to replace the internal backup battery. See “Replacing the Internal
Backup Battery” on page 45 for more information.
If you suspect a problem with your computer hardware
• You can use the included Apple Hardware Test CD to help determine if there is a
problem with one of your computer’s components, such as the memory or processor.

Locating Your Product Serial Number
You can find the serial number for your eMac on the inside of the optical drive door.
Press the Media Eject ( ) key on the keyboard to open the door. If you can’t turn on
your computer, you can open the drive door using a fingernail.
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You can use System Profiler to find out detailed
information about your eMac, such as the amount of
built-in memory, hard disk size, devices connected, and
the product serial number.
To access the information in System Profiler, choose Apple (K) > About This Mac from
the menu bar and then click More Info, or open System Profiler, located in Applications/
Utilities.

Click the triangles in the
window to show and
hide information in the
different categories.

Additional information is available on the Internet at www.apple.com/emac and
www.apple.com/support.
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For your safety and that of your equipment, follow the
rules in this appendix for cleaning and handling your
computer, as well as the guidelines for working more
comfortably.
Cleaning Your eMac
Follow these general rules when cleaning the outside of your computer and its
components:
• Shut down your eMac and disconnect all cables.
• Use a damp, soft, lint-free cloth to clean the computer’s exterior. Avoid getting
moisture in any openings. Do not spray liquid directly on the computer.
• Don’t use aerosol sprays, solvents, or abrasives.

Cleaning Your eMac Display
To clean your eMac screen, do the following:
• Shut down your eMac and disconnect all cables.
• Dampen a clean, soft, lint-free cloth or paper with water only and wipe the screen.
Do not spray liquid directly on the screen.
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Carrying Your eMac
Your eMac weighs about 50 pounds (22.7 kilograms). If possible, use two people
to lift it.
If you are lifting your eMac by yourself, stand with the screen facing you and hold the
bottom of the computer with both hands. Lift using your legs, rather than your back.

Safety Instructions for Setting Up and Using Your
Computer
For your own safety and that of your equipment, always take the following precautions.
Disconnect the power plug (by pulling the plug, not the cord) and disconnect the
phone cord if any of the following conditions exists:
• You want to remove any parts
• The power cord or plug becomes frayed or otherwise damaged
• You spill something into the case
• Your computer is exposed to rain or any other excess moisture
• Your computer has been dropped or the case has been otherwise damaged
• You suspect that your computer needs service or repair
• You want to clean the case (use only the recommended procedure described earlier)
Important: The only way to turn off power completely is to disconnect the power cord
and phone cords. Make sure at least one end of the power cord is within easy reach so
that you can unplug the computer when you need to.
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Warning: Your AC cord came equipped with a three-wire grounding plug (a plug
that has a third grounding pin). This plug will fit only a grounded AC outlet. If you
are unable to insert the plug into an outlet because the outlet is not grounded,
contact a licensed electrician to replace the outlet with a properly grounded
outlet. Do not defeat the purpose of the grounding plug.
Be sure that you always do the following:
• Keep your computer away from sources of liquids, such as drinks, washbasins,
bathtubs, shower stalls, and so on.
• Protect your computer from dampness or wet weather, such as rain, snow, and so on.
• Read all the installation instructions carefully before you plug your computer into a
wall socket.
• Keep these instructions handy for reference by you and others.
• Follow all instructions and warnings dealing with your system.
Important: Electrical equipment may be hazardous if misused. Operation of this
product, or similar products, must always be supervised by an adult. Do not allow
children access to the interior of any electrical product and do not permit them to
handle any cables.
Warning: Never push objects of any kind into this product through the openings
in the case. Doing so may be dangerous and result in fire or a dangerous electric
shock.

Apple and the Environment
Apple Computer, Inc., recognizes its responsibility to minimize the environmental
impacts of its operations and products.
ENERGY STAR Compliance
As an ENERGY STAR® partner, Apple has determined that standard configurations of this
product meet the ENERGY STAR guidelines for energy efficiency. The ENERGY STAR
program is a partnership with office product equipment manufacturers to promote
energy-efficiency. Reducing energy consumption of office products saves money and
reduces pollution by eliminating wasted energy.
For More Information
Go to www.apple.com/about/environment.
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Ergonomics
Keyboard
When you use the keyboard, your shoulders should be relaxed. Your upper arm and
forearm should form an angle that is slightly greater than a right angle, with your wrist
and hand in roughly a straight line.
Use a light touch when typing and keep your hands and fingers relaxed. Avoid rolling
your thumbs under your palms.
Change hand positions often to avoid fatigue. Some computer users may develop
discomfort in their hands, wrists, or arms after intensive work without breaks. If you
begin to develop chronic pain or discomfort in your hands, wrists, or arms, consult a
qualified health specialist.
Chair
An adjustable chair that provides firm, comfortable support is best. Adjust the height of
the chair so your thighs are horizontal and your feet flat on the floor. The back of the
chair should support your lower back (lumbar region). Follow the manufacturer’s
instructions for adjusting the backrest to fit your body properly.
You may have to raise your chair so your forearms and hands are at the proper angle to
the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a
footrest with adjustable height and tilt to make up for any gap between the floor and
your feet. Or you may lower the desktop to eliminate the need for a footrest. Another
option is to use a desk with a keyboard tray that’s lower than the regular work surface.
Mouse
Position the mouse at the same height as your keyboard and within a comfortable
reach.
Computer
Arrange the computer so the top of the screen is slightly below your eye level when
you’re sitting at the keyboard. The best distance from your eyes to the screen is up to
you, although most people seem to prefer 18 to 28 inches (45 to 70 cm).
Position the computer to minimize glare and reflections on the screen from overhead
lights and windows.
For More Information
Go to www.apple.com/about/ergonomics.
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You can use your eMac to browse the World Wide Web,
send email to friends and family, and chat in real time
over the Internet.
When you first start up Mac OS X, the Setup Assistant helps you enter your Internet
configuration information and sign up for an Internet service provider (ISP) if you don’t
already have one.
There are three kinds of Internet connections:
• Dialup connection: Your computer is plugged into a telephone wall jack using the
included telephone cable (with models that include a modem).
• High-speed DSL or cable modem connection: Your computer is plugged into a
special modem you get from an ISP using an Ethernet cable.
• Local area network (LAN): Your computer is plugged into a LAN using an Ethernet
cable. This type of connection is usually used in the workplace.
To connect to the Internet:
1 Get an account with an ISP. If you do not have an ISP account, the Setup Assistant can
help you get one. If you don’t want to use the ISP suggested by the Setup Assistant,
you can find an ISP in your phone directory. Look under “Internet access.”
Note: If you want to use America Online as your ISP, skip the Internet setup part of the
Setup Assistant. Then open the AOL Installer application (in Applications/Installers) and
follow the onscreen instructions to set up AOL.
2 Get information from your ISP (if you don’t want to use the ISP suggested by the Setup
Assistant). You can write the information directly on the next few pages (see “Setup
Assistant Worksheet” on page 62), then enter it in the Setup Assistant.
3 Plug the included phone cable into your computer’s modem port and into a phone
wall jack. Or, if you got a DSL or cable modem from your ISP, follow the instructions that
came with the modem to connect it to your computer.
4 Turn on your computer and enter information in the Setup Assistant to configure your
Internet connection.

61

LL2385.book Page 62 Thursday, September 4, 2003 5:20 PM

Note: If you already started your computer and did not use the Setup Assistant to
configure your Internet connection, choose Apple (K) > System Preferences and click
Network. Then click “Assist me.” The Setup Assistant opens.

Setup Assistant Worksheet
You can write the information you get from your ISP on these pages, then enter it in
the Setup Assistant.
Select how your computer connects to the Internet.
Telephone Modem
Cable Modem
DSL Modem
Local network (Ethernet)

To set up a telephone dialup connection, enter the following information:
User Name

Password

ISP Phone Number

Dialing prefix to obtain an outside line

To set up a DSL or cable modem or a LAN connection:
1 Choose your connection type. Ask your ISP for this information.
Manually
Manually using DHCP Router
Using DHCP
Using BootP
PPP
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2 Enter information from your ISP:
If you selected “Manually” or “Manually using DHCP Router,”* enter the
following:
IP Address

Subnet Mask

Router Address

* If you selected “Manually using DHCP Router,” you don’t need to enter a subnet mask or router address.

If you selected “Using DHCP,” enter the following:
DHCP Client ID

Note: DHCP Client ID is optional and may not be required. Ask your ISP.
If you selected “PPP (for PPPoE connections),” enter the following:
Service Provider (optional)

PPPoE Service Name (optional)

Account Name

Password

The information below is optional. Ask your ISP if you need to enter it.
DNS Hosts (optional for DHCP & BootP)

Domain Name (optional)

Proxy Server (optional)
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Troubleshooting Your Connection
Cable Modem, DSL, and LAN Internet Connections
If you can’t connect to the Internet using your cable modem, DSL, or local area network
(LAN), see the following steps.
Important: Instructions that refer to modems do not apply to LAN users. LAN users
may have hubs, switches, routers, or connection pods that cable and DSL modem users
do not. LAN users should contact their network administrator rather than an ISP.
Check the cables and power supplies
Make sure all modem cables are firmly plugged in, including the modem power cord,
the cable from the modem to the computer, and the cable from the modem to the wall
jack. Check the cables and power supplies to Ethernet hubs and routers.
Turn the modem on and off and reset the modem hardware
Turn off your DSL or cable modem for a few minutes, then turn it back on. Some ISPs
recommend that you unplug the modem’s power cord. If your modem has a reset
button, you can press it either before or after you turn the power off and on.

PPPoE Connections
If you are unable to connect to your Internet service provider using PPPoE, first check
the cables and power supplies, then turn the power off and on and reset the modem
hardware.
Check System Preferences settings
Use System Preferences (in the Apple menu) to verify that you’ve selected PPPoE and
to verify:
• Your account information
• Your TCP/IP settings
• That the primary network interface is set to Built-in Ethernet
Follow these steps:
1 Choose Apple (K) > System Preferences.
2 Click Network.
3 Choose Network Port Configurations from the Show pop-up menu.
4 Drag Built-in Ethernet to the top of the Port Configurations list.
5 Choose Built-in Ethernet from the Show pop-up menu.
6 Click PPPoE.
7 Select “Connect using PPPoE.”
8 Check the Account Name field to be sure you have entered the correct information
from your ISP.
9 Retype your password if you chose to save your password, to be sure it is correct.
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10 Click the TCP/IP tab. Follow your ISP’s instructions for setting up this pane.
11 Click Apply Now.

Network Connections
If you have two or more computers attempting to share an Internet connection, be
sure that your network is set up properly. You need to know if your ISP provides only
one IP address or if it provides multiple IP addresses.
If only one IP address is used, then you must have a router capable of sharing the
connection, also known as network address translation (NAT) or “IP masquerading.” For
setup information, check the documentation provided with your router or ask the
person who set up your network. The AirPort Base Station may be used for this routing
function. For information on using the AirPort Base Station, check the onscreen help or
visit the Apple AirPort website at www.apple.com/airport.
If you cannot resolve the issue using these steps, contact your ISP.
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Communications Regulation Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules.
Operation is subject to the following two
conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation. See instructions if
interference to radio or television reception is
suspected.
Radio and Television Interference
This computer equipment generates, uses, and can
radiate radio-frequency energy. If it is not installed
and used properly—that is, in strict accordance with
Apple’s instructions—it may cause interference with
radio and television reception.
This equipment has been tested and found to
comply with the limits for a Class B digital device in
accordance with the specifications in Part 15 of FCC
rules. These specifications are designed to provide
reasonable protection against such interference in a
residential installation. However, there is no
guarantee that interference will not occur in a
particular installation.

This product was tested for EMC compliance under
conditions that included the use of Apple peripheral
devices and Apple shielded cables and connectors
between system components. It is important that
you use Apple peripheral devices and shielded
cables and connectors between system components
to reduce the possibility of causing interference to
radios, television sets, and other electronic devices.
You can obtain Apple peripheral devices and the
proper shielded cables and connectors through an
Apple-authorized dealer. For non-Apple peripheral
devices, contact the manufacturer or dealer for
assistance.
Responsible party (contact for FCC matters
only): Apple Computer, Inc. Product Compliance, 1
Infinite Loop M/S 26-A, Cupertino, CA 95014-2084,
408-974-2000.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B
specifications. Cet appareil numérique de la classe B
est conforme à la norme NMB-003 du Canada. Cet
appareil numérique de la classe B est conforme à la
norme NMB-003 du Canada.
VCCI Class B Statement

You can determine whether your computer system is
causing interference by turning it off. If the
interference stops, it was probably caused by the
computer or one of the peripheral devices.
If your computer system does cause interference to
radio or television reception, try to correct the
interference by using one or more of the following
measures:
• Turn the television or radio antenna until the
interference stops.
• Move the computer to one side or the other of the
television or radio.
• Move the computer farther away from the
television or radio.
• Plug the computer into an outlet that is on a
different circuit from the television or radio. (That
is, make certain the computer and the television or
radio are on circuits controlled by different circuit
breakers or fuses.)
If necessary, consult an Apple-authorized service
provider or Apple. See the service and support
information that came with your Apple product. Or,
consult an experienced radio/television technician
for additional suggestions.
Changes or modifications to this product not
authorized by Apple Computer, Inc., could void the
EMC compliance and negate your authority to
operate the product.

European Community
Complies with European Directives 72/23/EEC and
89/336/EEC.
Laser Information
Making adjustments or performing procedures other
than those specified in your equipment’s manual
may result in hazardous radiation exposure.
Do not attempt to disassemble the cabinet
containing the laser. The laser beam used in this
product is harmful to the eyes. The use of optical
instruments, such as magnifying lenses, with this
product increases the potential hazard to your eyes.
For your safety, have this equipment serviced only
by an Apple-authorized service provider.
If you have an internal Apple CD-ROM, DVD-ROM, or
DVD-RAM drive in your computer, your computer is
a Class 1 laser product. The Class 1 label, located in a

67

LL2385FCC Page 68 Friday, September 12, 2003 2:26 PM

user-accessible area, indicates that the drive meets
minimum safety requirements. A service warning
label is located in a service-accessible area. The
labels on your product may differ slightly from the
ones shown here.

Class 1 label

Service warning label

Exposure to Radio Frequency Energy
The radiated output power of the optional AirPort
Extreme Card is far below the FCC radio frequency
exposure limits. Nevertheless, it is advised to use the
wireless equipment in such a manner that the
potential for human contact during normal
operation is minimized.
Mouse Class 1 LED Information
The Apple optical mouse is a Class 1 LED product in
accordance with IEC 60825-1 A1 A2. This product
complies with the requirements of European
Directives 72/23/EEC and 89/336/EEC.
It also complies with the Canadian ICES-003 Class B
Specification.
Taiwan Statement

Korea Statement

Apple Computer lnc.

Apple Computer lnc.

High-Risk Activities Warning
This computer system is not intended for use in the
operation of nuclear facilities, aircraft navigation or
communications systems, or air traffic control
machines, or for any other uses where the failure of
the computer system could lead to death, personal
injury or severe environmental damage.
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ENERGY STAR® Compliance
As an ENERGY STAR® partner, Apple has determined
that standard configurations of this product meet
the ENERGY STAR® guidelines for energy efficiency.
The ENERGY STAR® program is a partnership with
office product equipment manufacturers to promote
energy-efficiency. Reducing energy consumption of
office products saves money and reduces pollution
by eliminating wasted energy.

Telephone and Apple 56K Modem
Information
Notify Your Telephone Company
Some telephone companies require that you notify
the local business office when you hook up a
modem to their lines.
Information You Need in the United States
The internal modem complies with Part 68 of the
FCC rules. On the back of this equipment is a label
that contains, among other information, the FCC
registration number and ringer equivalence number
(REN). If requested, provide this information to your
telephone company.
• Ringer equivalence number (REN): 0.68 The REN is
useful to determine the quantity of devices you
may connect to your telephone lines and still have
all those devices ring when your telephone
number is called. In most, but not all areas, the
sum of the RENs of all devices connected to one
line should not exceed five (5.0). To be certain of
the number of devices you may connect to your
line, as determined by the REN, you should contact
your local telephone company to determine the
maximum REN for your calling area.
• Telephone jack type: USOC, RJ-11 An FCC-compliant
telephone cord and modular plug are provided
with this equipment. This equipment is designed
to be connected to the telephone network or
premises wiring using a compatible modular jack
that complies with Part 68 rules. See the
installation instructions for details.
Telephone Line Problems
If your telephone doesn’t work, there may be a
problem with your telephone line. Disconnect the
modem to see if the problem goes away. If it doesn’t,
report the problem either to your local telephone
company or to your company’s telecommunications
people.
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If disconnecting the modem eliminates the problem,
the modem itself may need service. See the service
and support information that came with your Apple
product for instructions on how to contact Apple or
an Apple-authorized service provider for assistance.
If you do not disconnect your modem when it is
adversely affecting the telephone line, the telephone
company has the right to disconnect your service
temporarily until you correct the problem. The
telephone company will notify you as soon as
possible. Also, you will be informed of your right to
file a complaint with the FCC.
The telephone company may make changes in its
facilities, equipment, operations, or procedures that
could affect the operation of your equipment. If this
happens, the telephone company will provide
advance notice in order for you to make the
necessary modifications to maintain uninterrupted
service.
The internal modem will not work with party lines,
cannot be connected to a coin-operated telephone,
and may not work with a private branch exchange
(PBX).
Telephone Consumer Protection Act
The Telephone Consumer Protection Act of 1991
makes it unlawful for any person to use a computer
or other electronic device to send any message via a
telephone fax machine unless such message clearly
contains, in a margin at the top or bottom of each
transmitted page or on the first page of the
transmission, the date and time it was sent and an
identification of the business or other entity, or
individual sending the message and the telephone
number of the sending machine of such business,
entity, or individual.
Information You Need in Canada
The Industry Canada (IC) label identifies certified
equipment. This certification means that the
equipment meets certain telecommunications
network protective, operational, and safety
requirements. The Department does not guarantee
the equipment will operate to a user’s satisfaction.
Before installing this equipment, make sure that you
are permitted to connect to the facilities of the local
telecommunications company. Be sure you use an
acceptable method of connection to install the
equipment. In some cases, you may extend the
company’s internal wiring for single-line individual
service by means of a certified telephone extension
cord. Be aware, however, that compliance with these
conditions may not prevent degradation of service
in some situations.

Repairs to certified equipment should be made by
an authorized Canadian maintenance facility
designated by the supplier. Any equipment
malfunctions or repairs or alterations that you make
to this equipment may cause the
telecommunications company to request that you
disconnect the equipment.
In Canada, contact Apple at: 7495 Birchmount Road,
Markham, Ontario, L3R 5G2, 800-263-3394
Warning: Users should ensure for their own
protection that the electrical ground connections of
the power utility, telephone lines, and internal
metallic water pipe system, if present, are connected
together. This precaution may be particularly
important in rural areas.
Users should not attempt to make such connections
themselves, but should contact the appropriate
electric inspection authority or electrician.
• Load number: 0.2 The load number (LN) assigned
to each terminal device denotes the percentage of
the total load to be connected to the telephone
loop that is used by the device, to prevent
overloading. The termination of a loop may consist
of any combination of devices, subject only to the
requirement that the sum of the load numbers of
all devices does not exceed 100.
• Telephone jack type: CA-11
Informations Destinées aux Utilisateurs Canadiens
L’étiquette d’Industrie Canada identifie un matériel
homologué. Cette étiquette certifie que le matériel
est conforme à certaines normes de protection,
d’exploitation et de sécurité des réseaux de
télécommunications. Le Ministère n’assure toutefois
pas que le matériel fonctionnera à la satisfaction de
l’utilisateur.
Avant d’installer ce matériel, l’utilisateur doit
s’assurer qu’il est permis de la raccorder au réseau de
l’enterprise locale de télécommunication. Le matériel
doit également être installé en suivant une méthode
acceptée de raccordement. Dans certains cas, le
câblage appartenant à l’enterprise utilisé pour un
service individuel à ligne unique peut être prolongé
au moyen d’un dispositif homologué de
raccordement (cordon prolongateur téléphonique).
L’abonné ne doit pas oublier qu’il est possible que la
conformité aux conditions énoncées ci-dessus
n’empêche pas la dégradation du service dans
certaines situations. De fait, les enterprises de
télécommunication ne permettent pas que l’on
raccorde un matériel aux prises d’abonnés, sauf dans
les cas précis prévus par les terifs particuliers de ces
enterprises.

69

LL2385.book Page 70 Thursday, September 4, 2003 5:20 PM

Les réparations de matériel homologué doivent être
effectuées par un centre d’entretien canadien
autorisé désigné par la fournisseur. La compagnie de
télécommunications peut demander à l’utilisateur de
débrancher un appareil suite à des réparations ou à
des modifications effectuées par l’utilisateur ou en
raison d’un mauvais fonctionnement.

Informationen fur Deutschland
Diese Modem-Karte ist als Endeinrichtung
vorgesehen und muss an ein TAE mit F-Kodierung
angeschlossen werden. Diese Endeinrichtung ist in
Konformität gemäss Niederspannungsrichtlinie 73 /
23 / EWG sowie EMC-Richtlinien 89 / 336 / EWG und
92 / 31 / EWG.

Veuillez contacter Apple pour des informations
supplémentaires:

Informations pour la France
Ce matériel est conforme aux normes applicables de
sécurité éléctrique d’après la directive 73 / 23 / CEE
et aux normes applicables de comptabilité
éléctromagnétique d’après la directive 89 / 336 /
CEE, modifié par la directive 92 / 31 / CEE.

Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
Service à la clientèle d’Apple Canada: 800-263-3394
Pour sa propre protection, l’utilisateur doit s’assurer
que tout les fils de mise à la terre du secteur, des
lignes téléphoniques et les canalisations d’eau
métalliques, s’il y en a, soient raccordés ensemble.
Cette précaution est particulièrement importante
dans les régions rurales.
L’utilisateur ne doit pas tenter de faire ces
raccordements lui-même; il doit avoir recours à une
service d’inspection des installations électriques ou à
un électricien, selon le cas.
• Numéro de charge: 0.2 L’indice de charge (IC)
assigné à chaque dispositif terminal indique, pour
éviter toute surcharge, le pourcentage de la
charge totale qui sera raccordée à un circuit
téléphonique bouclé utilisé par ce dispositif. La
terminaison du circuit bouclé peut être constituée
de n’importe quelle combinaison de dispositifs
pourvu que la somme des indices de charge de
l’ensemble des dispositifs ne dépasse pas 100.
• Type de prise téléphonique: CA-11
Information You Need in the United Kingdom
This terminal equipment is intended for direct
connection to the analogue Public Switched
Telecommunications Network and is approved for
use within the United Kingdom with the following
features:
• Modem facility
• Autocalling facility
• Autoanswer facility
• DTMF signaling
Operation in the absence of proceed indication or
upon detection of proceed indication
This product is in conformity with relevant
regulatory standards following the provisions of
European Council Directives 73/23/EEC (Low Voltage
Directive) and 89/336/EEC amended by 92/31/EEC
(EMC Directive).
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Information You Need in Australia
All telecommunications devices are required to be
labelled as complying to the Australian
telecommunications standards, ensuring the health
and safety of the operator and the integrity of the
Australian telecommunications network. To provide
compliance with the Australian Communications
Authority’s technical standards, please ensure that
the following AT commands are maintained:
• ATB0 (ITU/CCITT operation)
• AT&G0 (no guard tone)
• AT&P1 (33/66 pulse dial make/break ratio)
• ATS0 = 0 or ATS0 = 1 (no answer or answer greater
than one ring)
• ATS6 = 95 (DTMF period between 70–255 ms)
• ATS11 = 95 (DTMF period between 70–255 ms)
For calls that are automatically generated, a total of
three call attempts are allowed to a telephone
number, with a minimum period between calls of 2
seconds. If the call does not connect after three
attempts, 30 minutes must expire before automatic
redialing may be initiated. Failure to set the modem
(and any associated communications software) to
the above settings may result in the modem being
non-compliant with Australian telecommunications
standards. Under these circumstances a user could
be subject to significant penalties under the
Telecommunications Act 1997.
This modem must be properly secured in order for
you to use it. Telecommunications network voltages
exist inside the computer and the
telecommunications line connection must be
removed before opening the computer.
Information You Need in New Zealand
This modem is fully approved to operate on the New
Zealand telecommunications network under
Telepermit number PTC 211/01/096. All
telecommunications devices are required to hold a
Telepermit and be labelled accordingly with the
approved Telepermit number to comply with the
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New Zealand telecommunications standards,
ensuring the health and safety of the operator and
the integrity of the New Zealand
telecommunications network. To ensure compliance,
all calls that are automatically generated should not
make more than 10 call attempts to the same
number within any 30 minute period with a
minimum period between calls of 30 seconds.
Failure to adhere to these standards may result in
the modem being non-compliant with New Zealand
Telecom standards. Under these circumstances a
user could be subject to significant penalties.

Important: The grant of a Telepermit for any item of
terminal equipment indicates that only Telecom has
accepted that the item complies with minimum
conditions for connection to its network. It indicates
no endorsement of the product by Telecom, nor
does it provide any sort of warranty. Above all, it
provides no assurance that any item will work
correctly in all respects with another item of
Telepermitted equipment of a different make or
model, nor does it imply that any product is
compatible with all of Telecom’s network services.
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A
AirPort Extreme 13, 27
installing an AirPort Extreme Card 41
problems using 52
application freeze 21
applications 22
reinstalling applications 51
audio line in port 15
audio line out port 15

B
battery
replacing the internal backup battery 45
burning a CD-R or CD-RW disc 34
burning a DVD 35

C
cameras
digital 24
DV 26
carrying your eMac 58
CD
burning (recording) 34
CD-ROM drive 13, 32
changing
System Preferences 17
the desktop 17
cleaning your computer 57
Combo drive 13, 32
connecting
a printer 18
headphones 19
to a network 29
to an external display or VGA projector 30
to a TV, video projector, or VCR 30

Index

Index

cleaning 57
downloading software 19
DVD
burning (recording) 35
DVD-ROM/CD-RW Combo drive 13, 32
DVD-Video, playing 34

E
ejecting a disc 52
eject key 13
eMac
front view 12
side view 14
environment 59
ergonomics 60
Ethernet 29
port 15
external hard disks 26

F
FireWire
connecting devices 26
ports 15
FireWire Target Disk Mode 27
floppy disk drives 24
Force Quit 21
freezing up 50
frozen application 21

G
game pads 24

H
hard disks 26
headphone/audio line out port 15

D

I

date and time settings lost 53
dialup connection 61
digital video camera 26
display
adjusting 8

iDVD 35
inserting a CD or DVD 32
Internet
connecting to 8
problems connecting 52, 64
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date and time settings lost 53
ejecting a disc 52
Internet connection 52
network connections 65
problem with an application 52

settings 62
Internet service provider 61
iPod 26
ISP 61

J
joysticks 24

R
restoring your computer’s software 51

K
keyboard 7, 24
controls 36
ergonomics 60

M
Mac Help 22
Mac OS 9 16
Mac OS X 16
reinstalling 51
memory 15
installing additional memory 37
seeing how much memory your computer has 40
microphone 13
modem
cable 29, 61
DSL 29, 61
port 15
monitoring
a printer 18
mouse 7, 13
ergonomics 60

N
network connections 65

O
optical disc drive 13, 32

P
power button 15
power indicator light 13
power socket 15
Print & Fax preferences 18
printing 18
setup 18
problems
AirPort Extreme 52
computer freezes during startup 50
computer won’t respond 50
computer won’t start up 50
connecting to Internet 64
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Index

S
safety 58
scanners 24, 26
security slot 15
securing your computer 36
serial number 53
setting up a printer 18
setting up your computer 6
shutting down 9
sleep 9
Software Update 19
speakers 13
specifications 55
stopping
an application 21
SuperDrive 13, 32
System Preferences 17
System Profiler 55

T
transferring
files or documents 20
troubleshooting 49

U
updating software 19
USB 7, 24
connecting devices 24
hubs 25
ports 13, 15
using multiple devices at once 25

V
video out port 15, 30
volume controls 13

W
wireless networking and Internet
installing an AirPort Extreme Card 41
wireless networking and Internet access 27
working with a printer 18
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